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Chapter 1

Introducing QuickBooks

Topics
In this chapter, you will learn about the following topics:
e The QuickBooks Product Line (page 1)
e Accounting 101 (page 2)
e QuickBooks Files (page 5)
e Opening Portable Company Files (page 10)
e Restoring Backup Files (page 13)
e QuickBooks User Interface Features (page 18)
e Entering Transactions in QuickBooks (page 22)
e QuickBooks Help (page 27)

QuickBooks is one of the most powerful tools you will use in managing your business. QuickBooks isn’t
just a robust bookkeeping program; QuickBooks is a management tool. When set up and used
properly, QuickBooks allows you to track and manage income, expenses, bank accounts, receivables,
inventory, job costs, fixed assets, payables, loans, payroll, billable time, and equity in your company. It
also provides you with detailed reports that are essential to making good business decisions.

QuickBooks helps small business owners run their businesses efficiently without worrying about the
debits and credits of accounting entries. However, to use QuickBooks effectively, you still need to
understand how QuickBooks is structured, how its files work, how to navigate in the system to do
tasks, and how to retrieve information about your business. In this chapter you’ll learn some of the
basics of the QuickBooks program and then you will explore the world of accounting.

The QuickBooks Product Line

The QuickBooks family of products is designed to be easy to use, while providing a comprehensive set
of accounting tools including: general ledger, inventory, accounts receivable, accounts payable, sales
tax, and financial reporting. In addition, a variety of optional, fee-based payroll services, merchant
account services, and other add-on products integrate with the QuickBooks software.

QuickBooks Desktop vs. QuickBooks Online

Intuit offers two distinctly different ways to use QuickBooks. One version is installed on your local
computer and is referred to as QuickBooks Desktop. The other is a cloud-based application that isn’t
installed on your individual computer but is available online through a web browser or app on a
smartphone or tablet. This version is called QuickBooks Online. The online edition has different, yet
similar, features to QuickBooks Desktop. This textbook covers QuickBooks Desktop.

QuickBooks Versions

The QuickBooks Desktop product line includes several separate product editions: QuickBooks Pro,
QuickBooks Premier, QuickBooks Accountant, and QuickBooks Enterprise. The Premier and Enterprise
versions are further broken down into six industry-specific editions for General Business, General
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Contractor, Manufacturing & Wholesale, Nonprofit, Professional Services, and Retail. All editions of
QuickBooks support multiple users; however, each user must have the same version of QuickBooks to
access the file.

This book covers the features and usage of QuickBooks Pro, Premier (non-industry specific), and
Accountant, since most small businesses will use one of these editions. Also, once you learn how to
use one of these versions, you'll be prepared to use any of the other versions. For a comparison of all
products and options, see www.quickbooks.com.

Accounting 101

Having a basic background in the accounting process will help you learn QuickBooks and run your
business. In this section, we look at some basic accounting concepts and how they relate to
QuickBooks.

Accounting’s Focus

Accounting’s primary concern is the accurate recording and categorizing of transactions so that you
can produce reports that accurately portray the financial health of your organization. Put another way,
accounting’s focus is on whether your organization is succeeding and how well it is succeeding.

The purpose of accounting is to serve management, investors, creditors, and government agencies.
Accounting reports allow any of these groups to assess the financial position of the organization
relative to its debts (liabilities), its capabilities to satisfy those debts and continue operations (assets),
and the difference between them (net worth or equity).

The fundamental equation (called the Accounting Equation) that governs all accounting is:
Assets = Liabilities + Equity, or Equity = Assets - Liabilities.

The General Ledger

Many factors go into making an organization work. Money and value are attached to everything that is
associated with operating a company — cash, equipment, rent, utilities, wages, raw materials,
merchandise, and so on. For an organization to understand its financial position, business
transactions need to be recorded, summarized, balanced, and presented in reports according to the
rules of accounting.

Business transactions (e.g., sales, purchases, operating expense payments) are recorded in several
types of ledgers, called accounts. The summary of all transactions in all ledgers for a company is called
the General Ledger. A listing of every account in the General Ledger is called the Chart of Accounts.

Each account summarizes transactions that increase or decrease the equity in your organization. The
figure below shows a general picture of the effect your accounts have on the equity of your
organization. Some accounts (those on the left) increase equity when they are increased, while others
(those on the right) decrease equity when they are increased.

Inventory E Loan Interest
Cash Q
U Rent
—
Investments I
Capital Equipment T Wages
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So, let’s return to the accounting equation. To understand the accounting equation, consider the
following statement: Everything a company owns was purchased by funds from lenders, or the owner’s
stake in the company.

Account Types and Financial Reports

Each account in the general ledger has a type, which describes what kind of business transaction is
stored in that account. There are primarily five types of accounts: asset, liability, equity, income, and
expense. Assets, liabilities, and equity accounts are associated with the Balance Sheet report, which is
used to analyze the net worth of a business. The income and expense accounts are associated with
the Profit & Loss report (also called an Income Statement), which is used to analyze the operating
profit or loss for a business over a specific time range (month, quarter, year, etc.).

The Balance Sheet report preserves the fundamental accounting equation - Total assets always equal
the total liabilities plus equity, between the accounts. This means that the total of the assets (which
represent what the company “owns”) is always equal to the sum of the liabilities (representing what
the company owes) plus the equity (representing the owner’s interest in the company). Although
income and expense accounts are not directly shown in the accounting equation, they do affect this
equation via the equity account as shown below.

The income and expenses are tracked throughout the year, as business transactions occur, and are
totaled at the end of the year to calculate Net Income (or Loss). Net income (total revenues minus total
expenses) increases the owner’s equity in the business, and net loss (wWhen expenses exceed
revenues) decreases the owner’s equity in the business. Thus, the Income and Expense accounts
indirectly affect the Equity component of the accounting equation of Assets = Liabilities + Equity,
where Equity increases or decreases each year depending on whether the year’s income exceeds
expenses or not.

At the end of the year, the balance of each income and expense account is reset to zero so these
accounts can track the next year’s transactions.

Double-Entry Accounting

Double-entry accounting is the technique that makes the accounting equation work. It divides each
account into two sides. One side is a record of transactions that increase the account and the other
side is a record of all transactions that decrease the account. One side (the left side) is for debits, and
the other (the right side) is for credits. Depending on the type of account, a debit might increase the
account or decrease it. The same is true of credits. Therefore, debits are not always bad, and credits
are not always good. They are just part of the system of accounting. However, the rule of double-entry
accounting is that total debits must always equal total credits. Every transaction creates a debit in one
or more accounts and a credit in one or more accounts. If the debits and credits for any transaction
are not equal, the transaction has an error or is incomplete.

Accounting Behind the Scenes

Recording and categorizing all of your business transactions into the proper accounts, summarizing
and adjusting them, and then preparing financial statements can be an enormous, labor-intensive task
without the help of a computer and software. This is where QuickBooks comes in. QuickBooks focuses
on ease of use and hiding accounting details. To make all this possible, QuickBooks uses components
like accounts, items, forms, registers, and lists, which are discussed later in the chapter. Familiar-
looking forms such as invoices, checks, and bills are used for data entry. As you enter data in forms,
QuickBooks handles the accounting entries for you. Thus, business owners can use QuickBooks to
efficiently run a business without getting bogged down with the debits and credits of accounting
entries.
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QuickBooks also handles double-entry for you. Every transaction you enter in the program
automatically becomes a debit to one or more accounts and a credit to one or more other accounts.
QuickBooks won't let you record the transaction until the total of the debits equals the total of the
credits. This means you can create reports that show the transactions in the full double-entry
accounting format whenever you need them, allowing you to focus on the business transaction rather
than the debits and credits in the General Ledger.

Cash or accrual method, as discussed in the next section, is handled in QuickBooks as a simple
reporting option. You can create reports for either cash or accrual basis regardless of the method you
use for taxes.

As the book introduces new transaction types (e.g., Invoices, Bills, or Checks), the text will include a
section called “The Accounting Behind the Scenes.” For example, when you first learn about invoices
you will see the following message:

The Accounting Behind the Scenes:

When you create an Invoice, QuickBooks increases (with a debit) Accounts Receivable
and increases (with a credit) the appropriate Income account. If applicable, Invoices
and Sales Receipts also increase (with a credit) the sales tax liability account.

Letting QuickBooks handle the accounting behind the scenes means you can focus on your
organization and identify the important factors that will help you succeed. Once you identify these
factors, you can use QuickBooks to monitor them and provide information that will guide you in
managing your operations.

Accounting Basis: Cash or Accrual?

Another critical aspect of accounting is managing for the future. Many times, your organization will
have assets and liabilities that represent money owed to the company, or owed to others by the
company, but are not yet due. For example, you may have sold something to a customer and sent an
invoice, but the payment has not been received. In this case, you have an outstanding receivable.
Similarly, you may have a bill for insurance that is not yet due. In this case, you have an outstanding
payable.

An accounting system that uses the Accrual Basis method of accounting tracks these receivables and
payables and uses them to evaluate a company’s financial position. The accrual basis method
specifies that revenues and expenses are recognized in the period in which the transactions occur,
rather than in the period in which cash changes hands. This helps you more accurately understand the
true profitability of the business in each period. Assets, liabilities, income, and expenses are entered
when you know about them, and they are used to identify what you need on hand to meet both current
and known future obligations.

In the Cash Basis method, revenues and expenses are not recognized until cash changes hands. So,
revenue is recognized when the customer pays, and an expense is recognized when you pay the bill for
the expense.

Although certain types of companies can use the cash basis method of accounting, the accrual
method provides the most accurate picture for managing your business. Some organizations are not
allowed to operate as cash basis under IRS regulations. You should check with your tax accountant to
determine which accounting method — cash or accrual — is best for you.

In QuickBooks, you can record transactions such as invoices and bills to facilitate accrual basis
reporting, and still create cash basis reports that remove the receivables and payables. This gives you
the flexibility of selecting one basis for taxes and another for operational reporting, if you wish.
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Imagine Photography Business Scenario

Throughout this book, you will see references to a fictitious company called Imagine Photography.
Imagine Photography is a photography studio that also sells camera equipment. This company uses
QuickBooks for its accounting and business management. Imagine Photography may not be exactly
like your business; however, the examples in this text that focus on Imagine Photography are generic
enough to guide you on your own use of QuickBooks.

Imagine Photography has two locations, one in San Jose and another in Walnut Creek. In order for
management to separately track revenue and expenses for each store, Imagine Photography uses
Classes in QuickBooks. As you proceed through the book, you'll see how each transaction (bill, check,
invoice, etc.) is tagged with what class it belongs to, so that later you can create reports like the Profit
& Loss by Class. Classes can be used to separately track departments, profit centers, store locations,
or funds in any business.

Imagine Photography also needs to separately track revenue and expenses for each job it performs.
When a customer orders a photo shoot, Imagine Photography needs to track all of the revenue and

expenses specifically related to that job so it can look back and see how profitable the job was. This
concept is called Job Costing, and many different businesses need to track jobs in similar ways.

As you think through the examples with Imagine Photography, ask yourself what parallels you see to
your own organization. Certainly, areas such as salaries, supplies, equipment, and others will be
appropriate for your setup, but the names and specifics of the accounts, items, lists, and forms will
probably be different.

QuickBooks Files

Before using QuickBooks, it is important for you to understand how QuickBooks files are structured
and used. QuickBooks has three primary types of files described below. All file types can be opened
using the Open or Restore Company option from the File menu.

1. Working Data Files - These files are used to enter transactions and create reports. These are
also called the Company Files. (File Extension .QBW)

2. Portable Company Files -These files are a compact version of the company data files and are
used to transport the file between computers. These files should never be used to back up your
QuickBooks data. These files must be “Restored” to a working data file to be used. (File
Extension .QBM)

3. Backup Files -These files are a compressed version of the company data files and are used as
backup to safeguard the information. These files cannot be used directly within QuickBooks
and must be “Restored” to working data file format. (File Extension .QBB)

If you name your company file ABC, QuickBooks will store the working data file as “ABC.QBW.” When
you back up your company file using the QuickBooks Backup function, QuickBooks will store your
backup file with the name “ABC.QBB.” If you create a portable data file using the QuickBooks Portable
file creation function, the portable file “ABC.QBM” will be created.

In addition to the Backup and Restore process, which moves the complete QuickBooks file between
computers, QuickBooks also has a feature called the Accountant’s Copy. This feature enables an
accounting professional to review and make corrections to a special copy of the client’s company file
while the client continues to work. Then the client can merge the accountant’s changes back into the
original file. See the QuickBooks Help Index for information on this feature.

Important:

Each file type has a specific purpose and should be used accordingly. Working data files
are used to enter data and run reports, backup files are used to safeguard the data,
and portable files are compressed files used to transport data between computers
because smaller files transfer faster.
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Opening Recent Files

When QuickBooks opens, you will either see the No Company Open window (see Figure 1-1) or you will
be prompted to enter the password for the last working data file used.

The No Company Open window displays when you are opening QuickBooks for the first time, or if you
closed the working data file before exiting in your last session. By default, the last working data file
used reopens automatically if you closed the QuickBooks program without closing the file.

Double-click on a file to open it.

No Company Open

Select a company that you've previously opened and click Open

[COMPANY NAME LAST MODIFIED FILE SIZE

Intro-20.QBW 05/25/2020, 02:36 PM 115.52 MB
sample_product-based business.qbw \ 10/07/2019, 02:01 PM 47 41 MB

[ Previously Opened Files }

LOCATION: WMac\Dropbex for Business\Clients\Questiva\2020 Files\QuickBooks_2020_Solution_Files\Working Files\
Create a Open or restore an Open a *
new company existing company sample file

Edit List

Find a
company file

Figure 1-1 No Company Open window

Find a Company File

Click the Find a Company File box to scan your computer for all QuickBooks files (see Figure 1-2).

Find a Company File

Search for QUICKBOOKS files

NAME TveE

Intro-20 OBM
Inir0-20.08M

(EleEe | nvo20.08M

DATE MODIFIED = LOCATION
8212020 12055 Cisers)
/212020 12:06:5.
61272020 12055
/212020 12055,

Portabie File nistiatorRoyahwise S¢
CMUsersiAdministalorDropboriClie

CAUses\AGMInNSIr3onDIopboICle.

Fortable e

Portabis Fie
n0:20 Q8N

) ! samphe_product-
sampie_service-

Portavie Filg Chsers\AdministratorRoyahiss S¢
52772020 8581
52572020 252:1

512512000 1545

Campany File C:iUsers\PubliciDocumentsUnkilOL

Campany Fiie CAUserSPUDICDOCUMeNSINIOL

Gas Station - Co.. Gompany Fiie ChusersAdminsUralorDropbexPub
CUsersiAdministralorRoyahiise S¢
ChUsBrsAaMIniStiator

Cilsers\PublicDocumentslinkifiaL

Company File 5/25/2020 1:545.
91512019 123

91212010 §43 4

4= | GasStation-Co
O Cther Wortds - G Company File
sampie_conract,. Gompany File

[] Gpen fiis in musi-user made

ReScan Cancel

Figure 1-2 Find a Company File

Creating a New File

There are four ways to create a new QuickBooks file: Express Start, Detailed Start, Company Based on
an Existing Company, and Conversion from Other Accounting Software. Although it is possible to
create a QuickBooks file relatively quickly using Express Start, we recommend utilizing a 12-Step
process for creating a file to properly set up accounts and account balances. We have placed the
chapter that explains file setup later in the book so you will be able to utilize knowledge gained in
earlier chapters. You can learn more about file setup in our File Setup chapter starting on page 435.

Opening a QuickBooks Sample File

For learning purposes, QuickBooks provides sample data files that allow you to explore the program.

To open a sample data file, follow these steps:

Introducing QuickBooks



Introducing QuickBooks 7

COMPUTER PRACTICE

Step 1. Launch the QuickBooks program by double-clicking the icon on your desktop or
selecting it from the Windows Start menu.

Step 2. If you don’t see the No Company Open window, close the file that opens, or cancel the
password login box.

Step 3. Click Open a Sample file button and select Sample product-based business from the
list. The selected sample file will open with the QuickBooks Information screen (see
Figure 1-3).

QuickBooks Desktop Information

You're opening a QuickBooks
~ Desktop sample file.

Important: Use this sample file to practice while

you learn QuickBooks Desktop. Don't use it as

your company file.

While you're using this file, QuickBooks Desktop
will set today's date to 12/15/2022.

Figure 1-3 Sample File Information Screen

Step 4. Click OK to continue.

Step 5. The sample file you selected will open. If you see the Accountant Center or the
External Accountant message, close the window by clicking the X in the top right
corner. You can uncheck the box that says Show window when opening a company file
and close the window of the Accountant Center, or check Don’t show this again in the
External Accountant window.

Opening Other QuickBooks Data Files

If you want to open a QuickBooks company file other than the sample data files, follow the steps
below. We will not complete these steps now, but will use a restored portable file in the next section.

1. Launch the QuickBooks program by double-clicking the icon on your desktop or selecting it from
the Windows Start menu. When QuickBooks opens, it launches the data file you most recently
had open when you last exited the program, unless you specifically closed the data file before
exiting.

2. Toopen a different file, select the File menu and then choose Open or Restore Company (see
Figure 1-4). You can also click the Open or restore an existing company button on the No
Company Open window.

Edit View Lists Favorites Accountant Company

Mew Company...

Mew Company from Existing Company File. ..
Open Brevious Company h'. 3

Qpen Second Company =4
Figure 1-4 File menu

3. Inthe Open or Restore Company window, select Open a company file and click Next.
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Open or Restore Company

What type of file do you want to open or restore?

Open a company file

* Open a regular company file {.gbw)
* Open an Accountants Copy working file (.qba)

Restore a backup copy

+ Restore a backup file {.gbb)
* Restore files from an online backup

"' Restore a portable file

* Re-create a company file that was stored as a portable file (.gbm)

7 Convert an Accountant's Copy Transfer File
» Select an Accountant's Copy Transfer File ((QBX)
« Convert itto an Accountant's Copy working file(.QBA) and save it

Back ‘ Hext ’ Finish Help Cancel

Figure 1-5 Open or Restore Company

4. Use the Look in: field to navigate to the folder on your hard disk where you store your
QuickBooks file (see Figure 1-6).

Look in: QuickBooks 2020 Classroom Files |3
" Recent ltems
* B Desktop
1 Network
Quick access T Libraries
! <7 Royalwise Solutions Dropbox
3 Alicia Katz Pollock
Desktop @ OneDrive
= i This PG
(= ] & Downloads
Libraries S Daaiciop
4 3D Objects
[a # Docurnents
ol Questiva
This PC Working Files
= QuickBooks 2020 Salution Files
hla e L bUSIC

Figure 1-6 Selecting the folder where the QuickBooks files are stored

5. Select the file from the list of QuickBooks files, then click Open.

Note:

When you open a data file, depending on today’s date, you may see one or more
“Alerts” for learning to process credit cards, pay taxes, or similar activities. Click Mark
as Done when you see these alerts.

Your company file opens, and you are ready to work with QuickBooks.

Opening Multiple Files

It is possible to open two company files at the same time if you are using QuickBooks Accountant or
Enterprise. However, the activities that can be performed in the second file are very limited. We
recommend that you use one file at a time by closing a file before opening or restoring a different file.

Closing QuickBooks Files

Close the company data file by selecting Close Company from the File menu (see Figure 1-7). Skip this
step to open this data file automatically the next time you start the QuickBooks program.
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Edit View Lists Favorites Accountant Company

Mew Company... =
MNew Company from Existing Company File...

Open or Restore Company... I Ir]
Cpen Previous Company 3

Open Second Company
Back Up Company 3
Create Copy...

Close Company k.

Figure 1-7 Close Company File option

Closing the QuickBooks Program

Just as with any other Windows program, you can close the QuickBooks program by clicking the Close
button, which looks like an X, at the upper right hand corner of the QuickBooks window, or by selecting
Exit from the File menu.

The Exiting QuickBooks window appears to confirm that you want
to exit the QuickBooks program, as opposed to closing a window

in QuickBooks. You can disable this message by checking the box
& { Close afill-sersen window ] next to Do not display this message in the future (see Figure 1-9).

Manage
Sales Accounts Activies

Tax

ltems &
Senvices

{ Close QuickBooks

Figure 1-8 Closing QuickBooks and windows

Exiting QuickBooks Desktop

ﬂ Are you sure you want to exit QuickBooks Desktop?

Do not display this message in the future

Yes No

Figure 1-9 Exiting QuickBooks window

QuickBooks Updates and Releases

Occasionally, errors are found in the QuickBooks software after the product is released for sale. As
errors are discovered, Intuit fixes the problem and provides program “patches” via the Internet. Each
patch increases the Release Level of the QuickBooks application. To see what release level of the
software you have, press Ctri+1 (or F2) while QuickBooks is running. At the top of the window, you will
see the QuickBooks product information including the release level.

| Product QuickBooks Accountant Desktop 2020 Release RTP |

Figure 1-10 Product information window showing version and release

This book is based on QuickBooks Accountant 2020 Release R7P. If you have a different release, you
may see some slight differences compared to the screenshots in this book.

To patch your software with the latest maintenance update, download it by selecting the Help menu
and then choosing Update QuickBooks. Follow the instructions on these screens to download and
install maintenance releases in QuickBooks via the Internet.

Introducing QuickBooks



10 Introducing QuickBooks

Opening Portable Company Files

Portable Company Files are compact company data files that can be easily transported. The exercise
files that accompany this book are Portable Company Files. You will need to open these exercise files
at the start of each chapter and each problem.

Important:

When you move a data file from one computer (computer A) to another (computer B),
any data you enter on computer B will cause the file on the computer A to become
obsolete. Take care to make sure you are always working in the most recent data file.

COMPUTER PRACTICE
To open portable files follow the steps below.
Step 1. Select the Open or Restore Company option from the File menu.

Step 2. QuickBooks displays the Open or Restore Company window (see Figure 1-11). Select
Restore a portable file ((QBM) and click Next.

Open or Restore Company

What type of file do you want to open or restore?

" Open a company file

+ Open aregular company file {.gbw)
+ Open an Accountant's Copy working file (.gba)

"7 Restore a backup copy

+ Restore a backup file (.qbb)
+ Restore files from an online backup

® Restore a portable file

+ Re-create a company file that was stored as a portable file (.gbm)

7 Convert an Accountant's Copy Transfer File

+ Select an Accountants Copy Transfer File (QBX)
« Convert itto an Accountant's Copy working file(.QBA) and save it

Back | Next | Finish Help Cancel

Figure 1-11 Open or Restore Company window

Step 3. QuickBooks displays the Open Portable Company File window (see Figure 1-12).
Navigate to the location of your exercise files. You may need to ask your instructor if
you do not know this location. Once you are viewing the contents of the correct folder,
select Intro-20.QBM and click Open.

ab Open Portable Company File x
Look in: QuickBooks 2020 Classroom Files - SET@Y
l Name : Date modified Type Size
“ilintro-20.0BM 5/25/2020 3:19 PM QuickBooks Portable C... 989 KB
Quick access
Desktop
m
Libraries
This PC
Network File name: Intro-20.QBM it \ Open i
Files of type: QuickBooks Portable Company Files (*.QBM) : | cancel
Help

Figure 1-12 Open Portable Company File window
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Step 4.

Next you will need to tell QuickBooks where to save the working file that will be created
from the portable file (see Figure 1-13). Click Next in the Open or Restore Company

window to continue.

0 b

Where do you want to restore the file?

In the next window, you will choose the location where you want to restore the file. As
the file restores, it is converted to a company file with the extension .qbw.

Important: If you don't want to overwrite your existing company file, rename the file in
the next window. For example, you may want to add a date or version number such as
mycompanyname-Jan2-2007.qbw or mycompanyname-v2.qbw.

Cancel

Figure 1-13 Open or Restore Company Location

Step 5. The Save Company File as window displays (see Figure 1-14). Ask your instructor or
choose a location to save the file. When you have navigated to the appropriate folder,
click Save.

qb Save Company File as x
Save in: QuickBooks 2020 Classroom Files « oFemy
* Name h Date modified Type
No items match your search.
Quick access
Desktop
m
Libraries
ThlsrPC
Network
| >
File name: Intro-20.QBW = ‘ Save
Save as type: QuickBooks Files (*.QBW) 3 Cancel

~

Help .

Figure 1-14 Save Company File as window

Step 6.

The QuickBooks Desktop Login window opens (see Figure 1-15). The password to this
and every exercise file in this book is Questiva20. The password is case sensitive, so
make sure you capitalize the first letter Q in Questiva20. Enter Questiva20 in the

Password field and click OK.
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QuickBooks Desktop Login x

You need to log in as QuickBooks Desktop Administrator to proceed. Please
enter the admin (owner) password for the company:

Imagine Photography - Intro Chapter

Password: I| | forgot my password

Passwords are case sensitive.

Figure 1-15 QuickBooks Desktop Login window

Note:

Every QuickBooks file is required to have a complex password. It must be at least 7
characters long and contain at least one uppercase letter and one number. Although we
use the same password for all the exercise files in this textbook, we recommend that
you use a different password for your own or your employer’s QuickBooks file. For more
on passwords see page 472.

Step 7. If asked to update your company file, click Yes.

Step 8. If you see the QuickBooks Desktop Information window saying that the Portable
company file has been successfully opened, click OK to continue.

Step 9. Once the Intro-20.QBW company file finishes opening, you will see the Home page.
Creating Portable Company Files
You can also create a Portable file using the following steps:

COMPUTER PRACTICE

Step 1. Select the Create Copy option from the File menu (see Figure 1-16).

Edit View Lists Favorites Accountant Company Customers

Mew Company...

MNew Company from Existing Company File. ..
Dpen or Restore Company... I Insights
Open Previous Company 3

Open Second Company
Back Up Company b Y

! Create Copy... k =

Close Company P“r'-:hE'SE
Figure 1-16 Create Copy
Step 2. The Save Copy or Backup window displays. Select the Portable company file option

and click Next.
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Save Copy or Backup x

What type of file do you want to save?

) Backup copy

Create a backup copy of everything you need to re-create your company file in case
of accidental loss or damage to your data

‘# Portable company file
Create a compact version of your company financial data that you can e-mail or

temporarily move to another computer.

% " Accountant's Copy
Create a compact version of your company file. Your accountant will use it to make
adjustments that you can import into your file later.

To send this file to an Intuit web server, click Cancel now and go to File =
Accountant's Copy = Send to Accountant.

Help me choose

Bach \ Next \ Finish Help Cancel

Figure 1-17 Save Copy or Backup window

Step 3. The Save Portable Company File window appears. The default file name in the File
name field is the same as the working file name with “(Portable)” added to the end.
Navigate to the student file location and click Save.

Step 4. The message shown in Figure 1-18 will appear before the portable file is created. Click
OK to continue.

Close and reopen

QuickBooks must close and recpen your company
file before creating a portable company file.

Figure 1-18 Message for creating portable company file

Step 5. QuickBooks displays the QuickBooks Desktop Information dialog box (see Figure 1-19).
Click OK to return to the working data file.

QuickBooks Desktop Information

QuickBooks has saved a portable file
& version for Academy Photography -
~Intro Chapter to
\\Mac\Home\Desktop\Questiva\Working
Files\QuickBooks 2020 Classroom
Files\Iintro-20 (Portable).QBM.

Figure 1-19 Message that the Portable File has been successfully created

Restoring Backup Files

When working with important financial information, creating backup files is a crucial safeguard against
data loss. Every business should conduct regular backups of company information. QuickBooks has
useful tools to automate this process.

In the event of an emergency, you may need to restore lost or damaged data. For example, if your
computer’s hard drive fails, you can restore your backup onto another computer and continue to work.

Introducing QuickBooks
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Note:

Portable files should never be used as a substitute for backup files. Backup files are
larger than portable files and hold more information about the company.

Backing Up Your Data File

Backing up your data is one of the most important safeguards you have to ensure the safety of your
data.

COMPUTER PRACTICE
Step 1. To back up your company file, select Create Copy from the File menu.
Step 2. Choose Backup copy from the Save Copy or Backup window (see
Save Copy or Backup x
What type of file do you want to save?
' Backup copy
Create a backup copy of everything you need to re-create your company file in case
of accidental loss or damage to your data.
7 Portable company file
Create a compactversion of your company financial data that you can e-mail or
tempaorarily move to another computer.
7 Accountant's Copy
Create a compact version of your company file. Your accountant will use it to make
adjustments that you can import into your file |ater.
lNote: To send this file to an Intuit web server, click Cancel now and go to File =
Accountant's Copy = Send to Accountant.
Help me choose
Back | Next | Finish Help Cancel
Step 3. Figure 1-20). Click Next.
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Save Copy or Backup x

What type of file do you want to save?

Backup copy

of accidental loss or damage to your data.

Portable company file

temporarily move to another computer.
Q ' Accountant's Copy

adjustments that you can import into your file later.

Accountant's Copy = Send to Accountant.

Help me choose

Back E Einish

Create a backup copy of everything you need to re-create your company file in case

Create a compactversion of your company financial data that you can e-mail or

Create a compact version of your company file. Your accountant will use itto make

Mote: To sendthis file to an Intuit web server, click Cancel now and go to File =

Help

Cancel

15

Figure 1-20 Save Copy or Backup window

Step 4. You are given the option to save the backup to a local storage device, such as a
removable hard disk or a network folder. There is also an option for online backup
using a fee-based service available from Intuit. Online backup is a good option for

many companies who require offsite backups.

Choose Local backup and click Next.

Step 5. The Backup Options window is displayed (see Figure 1-21). Under the Local backup
only section, click the Browse button.

Use this window to set default options for your manual and automatic backups.

LOCAL BACKUF ONLY

Tell us where to save your backup copies {required)

Browse...

v| Add the date and time ofthe backup to the file name (recommended)

+ Limitthe number of backup copies in this folder to a

OMNLINE AND LOCAL BACKUP

+| Remind me to back up when | close my company file every 4 times.

Select an option to verify that your company data is OK (that is, not corrupted) when
you save.

@ Complete verification (recommended)
7 Quicker verification

7 No verification Help me choose

Figure 1-21 Backup Options window

Step 6. Select the folder where you want to store your backup file (see Figure 1-22). You
should store the backup files in a safe location, preferably on a different drive than
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your working data file. That way, if the drive with the working file is damaged, the
backup will still be available.

Browse for Folder

Select a location for your backups

| FreeAgent GoFlex Drive (F:)

> [E8l Control Panel —
5 e@ Homegroup
4 |88 Computer
> & 05 (C2)
» ey DVD RW Drive (D:)
> |y FreeAgent GoFlex Drive (F:)
| Photo Stream

v
oK J [ Cancel
Figure 1-22 Backup options Browse for Folder window
Step 7. When finished, click OK.
Step 8. The Save Copy or Backup window is displayed (see Figure 1-23). You can save a
backup now, schedule future backups, or both. Select Only schedule future backups
and click Next.

Save Copy or Backup

When do you want to save your backup copy?

% 7 Save it now

7 Save it now and schedule future backups

® Only schedule future backups

Mote: If you are saving your backup copy to a removable storage device such as a CD
or USB flash drive, insert the CD or connect the device now.

Back ! Next 1 Finish Help Cancel

Figure 1-23 Save Copy or Backup window

Step 9. In the Save Copy or Backup window, select New under the Back up on a schedule
area.

Introducing QuickBooks
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Save Copy or Backup

When do you want to backup your company file?

BACK UP AUTOMATICALLY:
Save backup copy automatically when | close my company file every

Click Options to view or change where the automatic

Options
backup copies will be saved. o

BACK UP ON A SCHEDULE:

% Click New to schedule regular backups of your company file.

New... Edit.. Remove

times

Cancel

17

Figure 1-24 Save Copy or Backup window

Step 10. The Schedule Backup window appears (see Figure 1-25). Enter a descriptive hame for

the backup, the location of the folder to contain the backups, and the time when the

backup file will be created.

Schedule Backup

DESCRIBE THE BACKUP TASK YOU WANT TO SCHEDULE:
Description yonday Night Backup

Location F4 Browse...

MNumber of backup copies to keep

SELECT THE TIME AND DAY YOU WANT TCr SAVE THE BACKUP:

Starttime 01 ~ |00 - AM -

Run this task every 9 — weeks on:

+ Monday Tuesday Wednesday
Thursday Friday Saturday
Sunday Store Password...

Figure 1-25 Schedule Backup window

Step 11. When finished, click OK to close the Schedule Backup window.

Step 12. The Store Windows Password window opens. Enter your Windows username and
password and click OK.

Step 13. Click Finish to close the Schedule Backup window.

Step 14. If necessary, click OK to close the QuickBooks: Backups have been scheduled as
specified. Window.

Step 15. If necessary, click No, Thanks for the offer to try Online Backup.

Introducing QuickBooks
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Restoring a Backup File
COMPUTER PRACTICE
Follow these steps to restore the QuickBooks backup file you just created:

Step 1. Select the File menu and then choose Open or Restore Company.

Step 2. Choose Restore a backup copy from the Open or Restore Company window and click
Next.

Step 3. In the Open or Restore Company window you can specify whether the file is stored
locally or through Intuit’s fee-based Online Backup service. Choose Local backup and
click Next.

Step 4. The Open Backup Copy window allows you to specify where your backup file is located.
Navigate to the folder that contains the file, select it and click Open.

Step 5. The Open or Restore Company window displays. Click Next.

Step 6. The Save Company File as window allows you to specify where to restore the working

files. Navigate to the appropriate folder and click Save. QuickBooks will then restore
your backup file in the folder you specified. You may be prompted to enter a password.
When QuickBooks restores the file, it creates a .QBW file.

Step 7. After completion, a window displays that the new file has been successfully restored
(see Figure 1-26).

QuickBooks Information

"6" Your data has been restored successfully.

Figure 1-26 After restoring backup file

Note:

When you restore a data file, depending on today’s date, you may see one or more
alerts for learning to process credit cards, pay taxes, or similar activities. Click Mark as
Done when you see these alerts.

QuickBooks User Interface Features

QuickBooks provides a number of shortcuts and tools that assist the user in entering information and
transactions. You should become familiar with these features so you can get to a task quickly. There
are various methods of accessing the data entry windows: the Home page, Snapshots, Menus,
QuickBooks Centers, Icon Bar, and Shortcut Keys.

Home Page

As soon as you open a company file, QuickBooks displays the Home page (Figure 1-27). The Home
page is broken into five sections, each dealing with a separate functional area of a business: Vendors,
Customers, Employees, Company, and Banking. Each area has icons to facilitate easy access to
QuickBooks tasks. The Home page also displays a workflow diagram showing the interdependency
between tasks.
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Tip:
Click on each of the area’s header buttons to open the corresponding Center.

= Home -0 %
VENDORS COMPAN
B - =b = -
B & ® =) %8
Purchase Receive Enter Bills Manage Chart of Inventory
Orders Inventory Against Sales Accounts Activities
Inventory Tax v
@ .
ltems & Order
Enter Bills Pay Bills Senvices Checks
CUSTOMERS .
% Calendar
Sales & Create Sales
Orders Accept Receipts BANKING
Credit Cards
= =N =
& = B &
Estimates Create Receive Record Reconcile
Invoices Payments Deposits
= & BB
Statement Statements Refunds AN
Write Check
Charges & Credits Checks Register
EMPLOYEES -
& B a ® =
" Print Enter Credit
Turn On Enter Pay Pay HR Essentials Checks Card Charges
Payroll Time Employees Liabilities and Insurance

Figure 1-27 QuickBooks Accountant 2020 Home page—your screen may vary

To start a task, just click on its icon on the Home page. If you close the Home page, it can be opened
by clicking on the Home icon on the Icon bar, or by selecting Home Page from the Company menu.

Icon Bar

The QuickBooks Icon Bar allows you to select centers, activities and available services by clicking icons
on the bar (see Figure 1-28). For example, you can open the Home page by clicking Home on the Icon
Bar.

Click the Collapse Arrow at the top of the blue Icon Bar to shrink it, giving you more workspace area.

The Icon Bar can also be moved to the top of the screen by clicking the View menu.

2400 - Homa | B

ustomess_Vendgm Emoicyess Banking Feports i

W tislp

Collapse
Arrow

% WHAT'S NEW

Figure 1-28 The Icon Bar
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Centers

QuickBooks Centers summarize pertinent information and transactions in one place. There are several
Centers for specific tasks. Centers can be opened from the Menus, Home page buttons, and the Icon

Bar.

Customer, Vendor, and Employee Centers are very important since they provide the only way to access
a list of your customers, vendors, and employees. These three lists are referred to as the Center-based
Lists. For example, when you click on the Customers section label in the Home page, the Customer
Center opens to show each customer’s balance, their general information, and all their transactions

(see Figure 1-29).

Active Customers - >

)

» Academy Training institute 0.00
+Anderson Wedding Planners 24954

Terms Net 30

7o BopMason

+Wilson, Sarah and ichast 000
«Bermy. Ron 000
»Crz Maria 1950.00
~Branch Opening 1950.00
»Easley Business Senices 0.00
+Feng, Tim 0.00
+Garison, John 0.00 Invoice

Transactions | Conlacls

v AlTransactions.

sy Porsat 000 imoics
T T
> McKowsky & Company 0.00.
< ianats Comar 119180
+Morris Consulting 0.00
< Otega servces 000
< et George oo
iz ves s 000
+42s8Late Oive 000
+ Pefez Jerry 0.00
o Staens Pircs & assoctts. CPas om0
+ Tueker and Johnsen, Inc. 0.00,

& lew Costomer 8Job v (3] New Trsnsactions v &5 oot v [] Excatv [T} Werd v G tcome Tracker

Customer Information

o Kumar, Sati and Naseen 24954 376 Pine St #5E
Morgan Hill, CA95111

ToRo's

2021904
3947

Al

Notes

Sent Email

010912021
1211812020

one 4085558225

11000 - Accounts Recaivadle
11000 - Accounts Receivale

77847
40139

Figure 1-29 Customer Center

Other Centers include the Bank Feeds Center, the Report Center, and the Doc Center. These Centers

will be addressed later in this book.

Calendar

You can view transactions on a Calendar. The calendar displays transactions on the Entered date and

the Due date.

Note:

Calendar.

The Entered date is not the date the transaction is entered into QuickBooks. It is the
date on each transaction form. If you create an invoice on January 5, 2021 and enter
the date 1/6/2021 in the date field, the invoice will show on January 6, 2021 on the

COMPUTER PRACTICE

Step 1. Click the Calendar icon on the Company section of the Home page.

Step 2. The Calendar window opens (see Figure 1-30). When finished, close the Calendar

window.
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@ ® January 2021 oy | (E[E[m) [vsen W o[ A Tangactions | =
sy wonD LESD ¥ Upcoming: Next 7 days (0)

1 2 ¥TaDO(8) Berm

* TRANSACTIONS (0} oun
B Due: Past 60 days (0)

3 4 Entered (1) 5 Entered (3) & Entered (1) 7 8 Enered (1) 9 Entered (11
*TODO (0) s
v TRANSACTIONS (0) Days.

10 11 12 13 Entered (1) 14 15 16

47 Duein) 18 Entered (1) 19 20 Due (1) 21 22 23

Ensered (2)

24 25 26 27 28 29 Entered (1} 30 Emeres 2)

31 l

]

Figure 1-30 QuickBooks Calendar - your screen may vary

Income Tracker

e
0.00
A ] o8 = (e ] oare (B 5
0 e | oATE ¥ SUE ONTE AnOuNT CREMBALANGE | LASTSENTOATE | STATUS  AcTion
o0 . i omers vz i s I N N
[J Mason, Bob Invoice 2021-104 17972021 20812021 776.47 776.47 Open
[J Miranda's Comer invoice 2021-103 1/8R2021 272021 1.191.80 1,191.80 Open
[ Crnuz, Maria:Branch Opening invoice 2021-102 14612021 2152021 500.00 500.00 Open
[0 Cruz, Maria:Branch Opening Invoice 2021-101 /512021 242021 570.00 570.00 Open
[] Anderson Wedding Planne. Invoice 4003 1212112020 12002021 24054 24954 Open
[J Mason Bob Invoice 3947 121872020 1172021 40139 40139 Open

Figure 1-31 Income Tracker - your screen may vary

The Income Tracker provides a fast way to see the status of your revenue-based transactions. Click on
the colored boxes in the Money Bar to filter the list for Estimates, Sales Orders, Unbilled Time &
Expenses, open and overdue Invoices, and recent Payments.

Snapshots

The Snapshots Center is a single-screen summary of different aspects of a company. Charts such as
Income and Expense Trends, Previous Year Income Comparison, and Expense Breakdown are
displayed along with important lists such as Account Balances and Customers Who Owe Money. The
Snapshots can be easily customized to show the information that is of most interest to you and your
company.

= Company Snapshot —rg %
Company | payments | Customer [
a
Add Content > Restore Default How do | customize this page? | & Print v
Income and Expense Trend w X Prev Year Income Comparison ¥ X Customers Who Owe Money v x
$in 1000s This yearto-date v Al ¥l Yearly ] . - R— - A
™ 31810008 Allard, Robert 092772019 14510.00
80 500 Mackey's Nursery and G. 11/04/2019 13,900.00
50 0 Pretell Real Estate 11/09/2019 5,026.50
© Cook, Brian 142019 | 920733
30 300 Hendro Riyadi 1111812019 422300
20 200 Vitton, David 11/30/2019 700.00
0 Teschner, Anton 1211312019 565.95
5 o Robson, Darci 12152018 | 12.42098
Jan Fen e May Jn M Ag Se O Nov Dec [ . Melton, Johnny 12/20/2019 861864

AR A W, N6 At 018 Burch, Jason 122512019 | 100500 |

W income NN Expense W Prior Year(s) W Current Year P

Account Balances ~ X TopCustomers by Sales S73q) \reviVoan ExpeneéCompariaon s

= pe— This yearto-date ~ A d ety v

: $in1000s

© Accounts Receivable 93,007.03 o
* Checking 46,969.10
© Accounts Payable 2663692 e ::
© Savings 17,910.10
el s I 200 -

Figure 1-32 Snapshots - your screen may vary
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Entering Transactions in QuickBooks

Each time you buy or sell products or services, pay a bill, make a deposit at the bank, or transfer
money, you enter a corresponding transaction into QuickBooks.

Each activity should have one action. For example, a customer paying off several invoices will still have
ONE Receive Payment form for the ONE check they handed you (more about that on page 58).

Forms

In QuickBooks, transactions are created by filling out familiar-looking Forms such as invoices, bills, and
checks. When you finish filling out a form, QuickBooks automatically records the accounting entries
behind the scenes. Most forms in QuickBooks have drop-down lists to allow you to pick from a list
instead of spelling out the name of a customer, vendor, item, or account.

By using forms to enter transactions, you provide QuickBooks with all of the details of each
transaction. For example, by using the Enter Bills form, QuickBooks tracks the vendor balance, the due
date of the bill, the discount terms, and the debits and credits in the General Ledger. This is a good
example of how QuickBooks handles the accounting behind the scenes.

Before QuickBooks, many bookkeepers used Journal Entries to manually enter accounting
transactions. Journal entries limit QuickBooks from providing management information beyond just the
debits and credits. If a form is available that achieves your goal, use it!

COMPUTER PRACTICE

Step 1. Click the Enter Bills icon in Vendors section of the Home page (see Figure 1-33).

B o

Purchase Receive
Orders Inventory

®

Enter Bills

=Y

Figure 1-33 Enter Bills on the Home page

Step 2. Click the Previous button in the upper left corner of the Enter Bills window until you see
the previously entered bill (see Figure 1-34).

Step 3. Click the down arrow next to the vendor field to see the drop-down list for vendors.

Step 4. Click the Calendar icon next to the date to see the Date Picker.

Step 5. When finished exploring, click the Revert button in the bottom right, which will return

the transaction to the last saved state.

Step 6. Close the Enter Bills window.
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= Enter Bills - O
Main  Reports =2
«* B B X Qoeeaew F § B O ke &
Find New Save Delete QMemoﬂ;e Print Attach Select Enter Clear Recalculate Pay
x v File PO Time Splits Bill
0 «| Bill Received
Bill [ Dropdown Arrow J \ Date Picker ]
p— ) 7 ‘
’ N SUMMARY
SR IR ocriguez Renals v] o 013012021
A e T e T e [ T T I Phone 925-555-3479
Rodri REF. NO 98527 =
anoress | Rodriguez Rentals Open balance 750.00
33 Wheeler Rd AR e 5 =
Walnut Creek, CA 94326 OUNTDLE {750.00 POs to be received 0
DUE 02/14/2021 B
erus  [Net15 v | Discount oate
MEMO Lighting Rental [ HIStOI‘y Pane
RECENT TRANSACTION &
Expenses $750.00 , ltems $0.00
01/30/21 Bill 750.00
62600 - EquipmentR... San Jose
[ Action Buttons ] 7
NOTES
Save & Close ‘ Save & New ] Revert

Figure 1-34 Anatomy of a Form

Lists

Lists are one of the most important building blocks of QuickBooks. Lists store information that is used
again and again to fill out forms. For example, when you set up a customer, including their name,
address and other details, QuickBooks can use the information to automatically fill out an invoice.
Similarly, after an Item is set up, QuickBooks automatically fills in its description, price, and associated
account information. This helps speed up data entry and reduce errors.

Note:

There are two kinds of lists — menu-based and center-based. Menu-based lists are
accessible through the Lists menu and populate the fields on forms. Center-based lists
include the Customer Center and Vendor Center, discussed on page 20.

Lists can be viewed by selecting an icon from the Home page (for example, the ltems & Services
button), choosing an option from the Lists menu, or viewing a list through one of the various
QuickBooks Centers.

Accounts

QuickBooks efficiently tracks all of your business transactions by categorizing them into Accounts in
your General Ledger. The Chart of Accounts is the list of these accounts.

COMPUTER PRACTICE

Step 1. To display the Chart of Accounts, click the Chart of Accounts icon on the Home page.

Alternatively, you could select Chart of Accounts from the List menu, or press Ctrl+A.

Step 2. Scroll through the list. Leave the Chart of Accounts open for the next exercise.

Introducing QuickBooks



24 Introducing QuickBooks

By default, the Chart of Accounts is sorted alphabetically within each account type (see Figure 1-35). If
you are using Account Numbers, the categories are sorted by account number.

Use the Search Box at the top to quickly find the account you need.

The Name column shows the account names that you assign. The Lightning Bolt indicates Bank Feed
connectivity. The Type column shows their account type. The Balance Total column shows the
balances for asset, liability, and equity accounts (except Retained Earnings). The Attach column shows
if there are attached documents.

<] Chart of Accounts -0 x
Look for account name or number
§
T N S Y N
+ 10200 - Money Market Bank 12,100.00 .
+10300 - Savings Bank 500.00
+ 10900 - Journal Entries Bank 0.00
11000 - Accounts Receivable Accounts Receivable 4,569.20
+ 12000 - Undeposited Funds Other CurrentAsset 0.00
+ 12100 - Inventory Asset Other CurrentAsset 647223
+ 12800 - Employee Advances Other CurrentAsset 0.00
+ 13100 - Prepaid Insurance Other CurrentAsset 0.00
+ 15000 - Furniture and Equipment Fixed Asset 13,250.00
+ 15200 - Buildings and Improvements Fixed Asset 0.00
+ 15600 - Land Fixed Asset 0.00
+ 15900 - Leasehold Improvements Fixed Asset 0.00
+ 16400 - Vehicles Fixed Asset 0.00
+ 17000 - Accumulated Depreciation Fixed Asset -1,325.00
+ 18700 - Security Deposits Asset OtherAsset 0.00
+ 20000 - Accounts Payable Accounts Payable 750.00
+ 22000 - National Bank VISA Gold Credit Card 0.00
+ 24000 - Payroll Liabilities Other Current Liability 368.00
+24010 - Company Payroll Taxes Payable Other Current Liability 368.00
+24020 - Employee Payroll Taxes Payable Other Current Liability 0.00
24030 - Other Payroll Liabilities Other Current Liability 0.00
+ 24200 - Line of Credit Other Current Liability 6,700.00 v|
Account v  Activities v  Reports v Attach

Figure 1-35 Chart of Accounts List

Registers

Each asset, liability, and equity account (except Retained Earnings) has a Register. Registers allow you
to view and edit transactions in a single window. Income and expense accounts do not have registers;
rather, their transactions must be viewed in a report.

COMPUTER PRACTICE

Step 1. To open the Checking account register, double-click on 10100 Checking in the Chart of
Accounts list.

Step 2. The Checking register opens (see Figure 1-36). Scroll through the register.
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= 10100 - Checking -0 %
& Goto.. | &) Print.. | B2 Edit Transaction [2) QuickReport Setup Bank Feeds
v
01/20/2021 6003 Wong & Son Video 142.00 14,212.48 —
BILLPMT 20000 - Accounts Payable Video Production Costs
01/20/2021 6004 Ace Supply 123.48 14,089.00
BILLPMT  -split- Acci# 43-234
01/30/2021 329 National Bank 2,152.00 11,937.00
CHK 22000 - National Bank VISAGold  1234-1234-1234-1234
02/07/2021 330 Nellis Distributing 375.00 11,562.00
BILLPMT 20000 - Accounts Payable
= v : il
ks v|
Splits ENDING BALANCE 1" ;562-00
1-Line
Sotby  Date, Type, Number/Ref = [ Recorg Restore
Figure 1-36 Checking account register
Step 3. Close the Checking account register by clicking the Close button in the upper right
corner.
Step 4. Double-click the 40000 Services account. You may need to scroll down. This is an
Income account.
Step 5. Instead of opening a register, QuickBooks opens a QuickReport (see Figure 1-37).
Step 6. If necessary, change the Dates field to All and click Refresh.
Step 7. Close the report.
Step 8. Close the Chart of Accounts.
= Account QuickReport -0 %
Customize Report Comment on Report S plat Memorize Print |v E-mail v Excel v Hide Header Refresh
Dates Custom * From 01/01/2021 § To 06/01/2021 @ SortBy Default -
Report Basis: @ Accrual Cash Show Filters
8:14 PM Imagine Photography - Intro Chapter
sine Account QuickReport
Accrual Basis January 1 through June 1, 2021
Type Date Num Name Memo Split Amount
40000 - Services
b Invoice 01/05/2021 2021-101 Cruz, Maria:Branc... Outdoor Pho. 11000 - Acco. 380.00 4
Invoice 01/05/2021 2021-101 Cruz, Maria:Branc.. Photo retouc. 11000 - Acco. 190.00
Invoice 01/06/2021 2021-102 Cruz, Maria:Branc... Photographer 11000 - Acco. 500.00
Invoice 01/09/2021 2021-104 Mason, Bob Indoor Studi. 11000 - Acco. 285.00
Invoice 01/09/2021 2021-104 Mason, Bob Photo retouc. 11000 - Acco... 380.00
Invoice 01/13/2021 2021-105 Cruz, Maria:Branc... Indoor Studi. 11000 - Acco 380.00
Invoice 017132021 2021-105 Cruz, Maria:Branc.. Photographer 11000 - Acco. 500.00
Total 40000 - Services 2615.00
TOTAL 2,615.00

Figure 1-37 A QuickReport

Items

Items are used to track a company’s services and products. Since every business has its own unique
set of products and services, QuickBooks needs to be customized by creating items for everything you
buy and sell. For more detail on items and the different item types, see page 271.

Iltems are necessary in order to use sales forms in QuickBooks (e.g., Invoices and Sales Receipts). On
an invoice, for example, each line has an item representing a product, service, discount, or sales tax.

When you define items, you associate them with accounts in the Chart of Accounts. This connection
between item names and accounts is the “magic” that allows QuickBooks to automatically create the
accounting entries behind each transaction.
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For example, Figure 1-39 displays the Item List. Take a look at Camera SR32, for example. It is
associated with a Sales Income account, Inventory Asset, and Cost of Goods Sold in the Chart of

Accounts. Every time the Camera SR32 item is added to an invoice, the dollar amount increases the
Sales account in the Chart of Accounts, and moves its original cost from Inventory to Cost of Goods.

COMPUTER PRACTICE

Step 1.

nage
jles
[rax

Services

To see what items are available in the file, click the Items & Services icon on the Home
page in the Company section (see Figure 1-38). Alternatively, you could select Iltem List

from the Lists menu.

COMPANY
Inventory
Activities

Order
Checks

Calendar

Figure 1-38 Items & Services button on Home page

Step 2.
=

Lookfor |

+ Photographer
+ Retouching

«+ Camera SR32
+ Case

+ Frame 5x7
«Lens

+ Photo Paper

+ Bad Debt

» Bounce Chg
+ Contra Costa
+ Qut of State

« Santa Clara

+ Premium Photo Package

+ Standard Photo Package

Figure 1-39 shows the Item List. Double-click the Camera SR32 item.

in Allfields

Qutdoor Photo Session
Photographer
Photo retouching services

Supra Digital Camera SR32

Camera and Lens High Impact Case

Picture Frame - 5 x 7" Metal Frame

Supra Zoom Lens

Search } Reset

ltem List

Senvice
Senvice
Senvice
Inventory Part
Inventary Part
Inventory Part

Inventory Part

Standard Photo Paper, Glossy, 8.5%11%, 7 Mil, Pack... Non-inventory Part

Bad Debt - Write off
Return Check Fee

Contra Costa County Sales Tax

Qut-of-state sale, exempt from sales tax

Santa Clara County Sales Tax

Premium Package of Photography from Session

Standard Package of Photography from Session

Non-inventory Part
Non-inventory Part
Other Charge
Other Charge
Sales Tax ltem
Sales Tax ltem

Sales Tax ltem

40000
40000
40000
45000
45000
45000
45000
45000
45000
45000
60300
45000
25500
25500
25500

Search within results

- Semices

- Semices

- Senices

- Sales

- Sales

- Sales

- Sales

- Sales

- Sales

- Sales

- Bad Debts

- Sales

- Bales Tax Payable
- Sales Tax Payable
- Sales Tax Payable

24
22

NAME DE TION TYPE ACCOUNT TOTAL QUANTIT ON SALE
- Indoor Photo Session | Indaor Studio Session senice  |40000 - Senices I

+ Qutdoor Photo Session

o o o o

RICE A

95.00
125.00
95.00
695.99
79.99
5.99
324.99
12.36
85.00
55.00
0.00
0.00
8.25%
0.0%
8.25%

Item

Activities | v

Reports |* | Excel v

Attach

Figure 1-39 Item List

Step 3.
Step 4.

Step 5.

If the New Feature window opens, click OK.

The Edit Item window opens (see Figure 1-40). Notice this item is linked to the Sales
account. Every time this item is entered on an invoice, it adds the purchase price to

Sales Income.

Close the Edit Item and Item List windows.
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= Edit Item -0 %
TYPE l OK I
Inventory Part » Useforgoods you purchase, track as inventory, and resell.
Cancel
New Note
Item Name/Number Subitem of Manufacturers Part Number

Camera SR32
UNIT OF MEASURE

Enable...

PURCHASE INFORMATION

Description on Purchase Transactions

Supra Digital Camera SR32

Cost 450.00

Preferred Vendor

COGS Account 50000 - Cost of Goods... «

Custom Fields

Spelling

SALES INFORMATION
Description on Sales Transactions

Supra Digital Camera SR32

Item is inactive

Sales Price 695.99
Tax Code Tax v
Income Account 45000 - Sales =

[ Cost Account ]

AssetAccount
12100 - Invento...

InventoryAccount] [ Income Account J

On Hand ""‘”?99 OnPO. On Sales Order
08
9 450,00 0 0

Figure 1-40 Camera SR32 Edit Item window

QuickBooks Help

Support Resources

QuickBooks provides a variety of support resources that assist in using the program. Some of these
resources are on the Internet and others are stored in Help files locally along with the QuickBooks
software on your computer. To access the support resources, select the Help menu and then choose
QuickBooks Desktop Help, or press F1 on your keyboard. QuickBooks will display context-sensitive
answers to problems you might be having, based on the window you have open. You can also enter a
question and QuickBooks will search its Help Content and the Online Community for related answers.

You can also access Support through messaging and call back options.

Certified QuickBooks ProAdvisors

Certified QuickBooks ProAdvisors are independent consultants, accountants, bookkeepers, and
educators who are proficient in QuickBooks, who can offer guidance to small businesses in various
areas of business accounting. To find a Certified ProAdvisor, select Find a Local QuickBooks Desktop

Expert from the Help menu.
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Review Questions

Comprehension Questions

1.

Explain the difference between a QuickBooks working data file, a QuickBooks backup file and a
QuickBooks portable file. How can you differentiate between the three types of files on your
hard disk?

What is the main reason for creating portable files?
Explain the importance of the QuickBooks Home page.

Explain why it is important to enter transactions in QuickBooks using Forms rather than
accounting entries.

Describe the primary purpose of accounting in business.

Multiple Choice

Select the best answer(s) for each of the following:

1.

The fundamental accounting equation that governs all accounting is:

a) Netincome = Revenue - expenses.
b) Assets + Liabilities = Equity.
c) Assets = Liabilities + Equity.
d) Assets = Liabilities - Equity.

Which of the following statements is true?

a) Debits are bad because they reduce income.
b) Equity is increased by a net loss.

c) Debits - credits = 0.

d) Assets are increased with a credit entry.

Under accrual accounting:

a) Asaleis not recorded until the customer pays the bill.

b) Income and expenses are recognized when transactions occur.
c) An expense is not recorded until you write the check.

d) You must maintain two separate accounting systems.

QuickBooks is:
a) Ajob costing system.
b) A payroll system.
c) A double-entry accounting system.
d) All of the above.

Which is not a method of accessing the data entry screens?
a) Menus
) Home page

c) lcon bar
) Data entry button
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Completion Statements

1. Asyou enter data in familiar-looking QuickBooks handles the entries for
you.

2. You should your data file regularly because it is one of the most important
safeguards you can do to ensure the safety of your data.

3.  When you open your working data file, QuickBooks displays the _ . This screen is
broken into five sections - each dealing with a separate functional area of a business.

4. are used in QuickBooks Sales forms and represent what the company buys and
sells.

5. Alist which shows all the accounts in your working data file is called the

Introduction Problem 1

| Restore the Intro-20Problem1.QBM file. The password to access this file is Questiva20.

1. Select Customers from the QuickBooks Icon Bar. This will display the Customer Center.
a) What s the first customer listed on the left of the Customer Center?

Note:

The answer to this first question is AAA Services. If you don’t see AAA Services in the
Customer Center, make sure to restore Intro-20Problem1.QBM as directed in the box
above. This book uses specific files for each chapter and each problem. If you don’t
restore the correct file, you will have trouble completing the exercises.

b) Inthe Customers & Jobs Center, single click on Mason, Bob. What is Bob Mason’s
balance?

c) Click the Date drop down list above the transaction listing in the right-hand panel and
scroll up to the top of the list to select All. How many transactions do you see and of what
type?

d) Close the Customer Center.

2. From the Home Page, click the Enter Bills icon. The Enter Bills window opens.

a) Click the Previous button in the upper left corner. What is the name of the vendor
displayed on this bill?
b) What is the Bill Due date on this bill?

3. From the Home page, click the Chart of Accounts icon to display the Chart of Accounts.

a) What type of account is the Checking Account?
b) How many total accounts are there of this same type?
¢) What is the Balance Total for the Money Market account?
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Introduction Problem 2 (Advanced)

| Restore the Intro-20Problem2.QBM file. The password to access this file is Questiva20.

1. Select Customers from the QuickBooks Icon Bar. This will display the Customer Center.

a) What is the first customer listed on the left of the Customer Center?

Note:

The answer to this first question is ABC International. If you don’t see ABC International
in the Customer Center, make sure to restore Intro-20Problem2.QBM as directed in the
box above. This book uses specific files for each chapter and each problem. If you don’t
restore the correct file, you will have trouble completing the exercises.

b) Inthe Customers & Jobs Center, single click on Cruz, Maria. What is Maria Cruz’s
balance?

c) Click the Date drop down list above the transaction listing in the right-hand panel and
scroll up to the top of the list to select All. How many transactions do you see and of what
type?

d) Close the Customer Center.

Select Vendors from the QuickBooks Icon Bar. This displays the Vendor Center.
a) Double-click Boswell Consulting . This opens the Edit Vendor window. What is their
address? Close the Edit Vendor window.

b) Single click on Sinclair Insurance. What is the amount of Bill number 5055 to Sinclair
Insurance (you may need to set the Date to All as in Step 1).

c) Close the Vendor Center.

From the Home page, click the Chart of Accounts icon to display the Chart of Accounts.

a) What type of account is Payroll Liabilities?
b) How many accounts of the type Fixed Asset are in the Chart of Accounts?
c¢) How many accounts of the type Other Current Asset are in the Chart of Accounts?

While still in the Chart of Accounts, double-click the Checking account on the Chart of Accounts
list. This will open the register for the Checking account.

a) Who was the payee for the check on 2/10/20217?

b) What was the amount of the check?

c) Close the checking account register and Chart of Accounts list.

Click the Create Invoices icon on the Home page, and then click on the Previous arrow (top
left).

a) What is the Invoice Number?

b) Who is the customer listed on this invoice?

c) What is the first item listed on this invoice?

d) Close the invoice.

Select the Chart of Accounts option from the Lists menu. Double-click on the Checking
account.
a) Which vendor was paid by the last bill payment (BILLPMT) in the register?
b) What is the Bill Payment Number?
¢) What is the amount of the last bill payment in the register?
d) Close the Checking register and close the Chart of Accounts list.
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7. Click the Write Checks icon on the Home page and follow these steps:
a) Click on the Calendar icon immediately to the right of the Date field. Select tomorrow’s
date in the Date field and press Tab.
) Inthe Pay to the Order of field, enter Ace Supply. Press Tab.
) Enter 80.00 in the Amount field and press Tab.
)
)

Q O T

Check the Print Later check box at the top of the window.
What is the city displayed in the Address field on the check for Ace Supply?
) Click Clear and then close the check window.

0]

8. Select the Chart of Accounts option from the Lists menu and double-click on Accounts
Receivable.
a) What is the ending balance in the account?
b) Who was the customer on the last transaction in the register?
c) Close the register and the Chart of Accounts.

9. Click the Check Register icon on the Home page.

a) Select 10100 - Checking from the Use Register dialog box.
b) What is the ending balance in the checking register?
c) Close the checking register.

10. Close the working data file Intro-20Problem2.QBW.
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